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AXIS COMMUNICATIONS<Product Name> Quick User’s Guide

About This Document
This manual is intended for administrators and users of the 
AXIS 233D Network Dome Camera, and is applicable for 
software release 4.40. It includes instructions for using and 
managing the AXIS 233D on your network. Previous 
experience of networking will be of use when installing 
and using this product. Some knowledge of UNIX or 
Linux-based systems would also be beneficial, for 
developing shell scripts and applications. Later versions of 
this document will be posted to the Axis Website, as 
required. See also the product’s online help, available via 
the Web-based interface.

Intellectual Property Rights
Axis AB has intellectual property rights relating to 
technology embodied in the product described in this 
document. In particular, and without limitation, these 
intellectual property rights may include one or more of the 
patents listed at http://www.axis.com/patent.htm and one 
or more additional patents or pending patent applications 
in the US and other countries.
This product includes software developed by the OpenSSL 
Project for use in the OpenSSL Toolkit: 
http://www.openssl.org/

Legal Considerations
Camera surveillance can be prohibited by laws that vary 
from country to country. Check the laws in your local 
region before using this product for surveillance purposes. 
This product includes one (1) MPEG-4 decoder license. To 
purchase further licenses, contact your reseller.

Electromagnetic Compatibility (EMC)
This equipment generates, uses and can radiate radio 
frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful 
interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular 
installation.
If this equipment does cause harmful interference to radio 
or television reception, which can be determined by turning 
the equipment off and on, the user is encouraged to try to 
correct the interference by one or more of the following 
measures: Re-orient or relocate the receiving antenna. 
Increase the separation between the equipment and 
receiver. Connect the equipment to an outlet on a different 
circuit to the receiver. Consult your dealer or an 
experienced radio/TV technician for help. Shielded (STP) 
network cables must be used with this unit to ensure 
compliance with EMC standards.

USA - This equipment has been tested and found to 
comply with the limits for a Class B computing device 
pursuant to Subpart B of Part 15 of FCC rules, which are 
designed to provide reasonable protection against such 
interference when operated in a commercial environment. 
Operation of this equipment in a residential area is likely to 
cause interference, in which case the user at his/her own 
expense will be required to take whatever measures may be 
required to correct the interference. 

Canada - This Class B digital apparatus complies with 
Canadian ICES-003.

Europe  -  This digital equipment fulfills the 
requirements for radiated emission according to limit B of 
EN55022/1998, and the requirements for immunity 
according to EN55024/1998 residential, commercial, and 
light industry. 

Japan - This is a class B product based on the standard of 
the Voluntary Control Council for Interference from 
Information Technology Equipment (VCCI). If this is used 
near a radio or television receiver in a domestic environment, it 
may cause radio interference. Install and use the equipment 
according to the instruction manual.

Australia - This electronic device meets the requirements of 
the Radio communications (Electromagnetic Compatibility) 
Standard 1998 AS/NZS 3548. 

Liability
Every care has been taken in the preparation of this manual; 
Please inform your local Axis office of any inaccuracies or 
omissions. Axis Communications AB cannot be held responsible 
for any technical or typographical errors and reserves the right 
to make changes to the product and manuals without prior 
notice. Axis Communications AB makes no warranty of any 
kind with regard to the material contained within this 
document, including, but not limited to, the implied warranties 
of merchantability and fitness for a particular purpose. Axis 
Communications AB shall not be liable nor responsible for 
incidental or consequential damages in connection with the 
furnishing, performance or use of this material.

Trademark Acknowledgments
Acrobat, Adobe, Boa, Ethernet, IBM, Internet Explorer, Linux, 
Macintosh, Microsoft, Mozilla, Netscape Navigator, UNIX, 
Windows, WWW are registered trademarks of the respective 
holders. Java and all Java-based trademarks and logos are 
trademarks or registered trademarks of Sun Microsystems, Inc. 
in the United States and other countries. UPnP is a certification 
mark of the UPnPTM Implementers Corporation. Axis 
Communications AB is independent of Sun Microsystems Inc.

WEEE Directive
The European Union has enacted a Directive 2002/96/EC 
on Waste Electrical and Electronic Equipment (WEEE 
Directive). This directive is applicable in the European 
Union member states.

The WEEE marking on this product (see right) or its 
documentation indicates that the product must not be 
disposed of together with household waste. To prevent possible 
harm to human health and/or the environment, the product must 
be disposed of in an approved and environmentally safe recycling 
process. For further information on how to dispose of this product 
correctly, contact the product supplier, or the local authority 
responsible for waste disposal in your area. 

Business users should contact the product supplier for 
information on how to dispose of this product correctly. This 
product should not be mixed with other commercial waste.

Axis Customer Services
Should you require any technical assistance, please contact 
your Axis reseller. If your questions cannot be answered 
immediately, your reseller will forward your queries through 
the appropriate channels to ensure a rapid response. If you are 
connected to the Internet, you can:
• download user documentation and firmware updates
• find answers to resolved problems in the FAQ database. 

Search by product, category, or phrases
• report problems to Axis support staff by logging in to your 

private support area
• visit the Axis Support Web at www.axis.com/techsup/
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Safety Notice - Battery Replacement
The AXIS 233D uses a 3.0V CR2032 Lithium battery as the 
power supply for its internal real-time clock (RTC). This 
battery will, under normal conditions, last for a minimum 
of 5 years. Low battery power affects the operation of the 
RTC, causing it to reset at every power-up. A log message 
will appear when battery replacement is required.
The battery should not be replaced unless required!
If the battery does need replacing, please observe the 
following points:
Caution!
• Danger of Explosion if battery is incorrectly replaced
• Replace only with the same or equivalent battery, 
as recommended by the manufacturer.
• Dispose of used batteries according to the manufacturer's 
instructions.
 

AXIS 233D Network Dome Camera User’s Manual 
Revision 1.1
Date: June 2007 
Part No: 29064
Copyright© Axis Communications AB, 2007
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 6 AXIS 233D - Product Overview
Product Overview
The AXIS 233D Network Dome Camera is a high-performance, progressive-scan camera 
with security features such as HTTPS and IP address filtering for use in professional and 
demanding surveillance situations.

The perfect choice for large area surveillance environments where superior image quality 
on moving objects is important from a long distance. 

Key Features
• 35x Zoom with EIS- EIS (Electronic Image Stabilizer) reduces the effect of the 

vibrations on the image. This feature is especially useful when the network 
camera is installed in places that are subject to vibrations such as near a highway

• Wide Dynamic Range - provides a better image in extreme lighting conditions
• Area zoom - Draw a square in the live view with your mouse and the AXIS 233D 

will zoom in that area
• Full frame rate at all resolutions in MPEG-4 or Motion JPEG
• E-flip - Electronic Flip inverts the image when a tracked target moves under the 

camera. 
• Pan and Tilt speed: 0.05 - 450o/Sec
• Two-way audio
• Pre-/post-alarm buffer
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Overview

Network
Restart button

Control button

Indicator
Status LED

Power/Audio

I/O terminal Connector

Serial number label

Network connector - The AXIS 233D connects to the network via a RJ-45 Ethernet 
connector. Using shielded cables is recommended.

Power/Audio connector - for connecting power supply and audio. See  Power connections, 
on page 53.

I/O terminal connectors - The AXIS 233D has 3 (8 pin) I/O terminal connectors that 
provide the physical interface to four solid state relay outputs, 4 alarm inputs, auxiliary 
power and ground. See  I/O terminal connector blocks, on page 54
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Serial number - This number is located on the product label at the base of the camera and 
is used during installation and restoring the camera to factory default settings. Included in 
the package is an extra product label, put this in a safe place for future reference. 

Restart button - This button power cycles the camera and is to be used during firmware 
upgrade or factory reset.

Control button - This button is used to restore the factory default settings as described in  
Resetting to Factory Default Settings, on page 51.

For instructions on how to install the AXIS 233D please refer to the Installation Guide 
which is supplied with the product in printed format or in PDF format from the Axis Web 
site at http://www.axis.com

Status LED Indicator
After completion of the startup and self test routines, the indicator flashes as follows. For 
more indicator flash routines see page 58.

Unlit Steady connection/normal operation
Amber Steady for system initiating. Flashes during 

firmware upgrade or reset to factory 
default

Amber/red Flashes amber/red for no network connec-
tion

Red Flashes red for firmware upgrade failure
Green Shows steady green for 10 sec. for normal 

operation after restart

Color Description
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Using the Network Dome Camera
This document includes instructions for using and managing the AXIS 233D. For 
instructions on how to install the AXIS 233D on your network refer to the Installation 
Guide which is supplied with the product in printed format or in PDF format from the Axis 
Web site at http://www.axis.com

The AXIS 233D can be used with most standard operating systems and supports Microsoft 
Internet Explorer 6.x or later, Netscape 7.x or later and Mozilla 1.4 or later.

Accessing the AXIS 233D

1. Start a Web browser (Internet Explorer, Mozilla, Netscape Navigator).

2. Enter the IP address or host name 
of the AXIS 233D in the 
Location/Address field of your 
Web browser.

3. Enter the user name and password set by the administrator. 

4. A video image is displayed in your Web browser. 

Note: • To be able to view streaming video in Microsoft Internet Explorer, you must set your Web browser to allow 
ActiveX controls. If your working environment restricts the use of additional software components, you can 
configure the AXIS 233D to use a Java applet for updating images. Please refer to the online help files for 
more information.

• User functions in the AXIS 233D may have been customized to meet the specific requirements of the 
application. Consequently, many of the examples and functions in this section may differ from those 
displayed in your Live View page.
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If the AXIS 233D has been customized, the buttons and other items described below will be 
displayed accordingly on the Live View page. The following provides an overview of each 
button:

 
The Video Format drop-down list allows the video format on the Live 
View page to be temporarily changed.

The Output buttons control an output directly from the Live View page. These 
buttons are configured under Setup > Live View Config > Layout.

Pulse - click this button to activate the port for a defined period of time, e.g. to 
switch on a light for 20 seconds. 
Active/Inactive - click these buttons to manually start and stop a connected 
device, e.g. switch a light on/off.

These buttons start/stop the Sequence Mode. This mode is created in Setup > 
Live View Config > Sequence mode and automatically displays the view from 
preset positions at set intervals.

The Action buttons trigger an action directly from the Live View page. These 
buttons are configured under Setup > Live View Config > Layout. Click these 
buttons to manually start and stop events.

Use the Snapshot button to capture a snapshot of the image currently being 
displayed in the window. Right-click on the image to save it in JPEG format 
on your computer.
  
Click the Ctrl panel button to access the following buttons:

• Auto focus: Automatically adjusts the image focus.
• Auto iris: Automatically adjusts the amount of light reaching 

the image sensor for best image results.
• Backlight comp: Enabling backlight compensation makes the 

subject clearer if the image background is too bright, or if the 
subject is too dark. 

• IR cut filter: When set to off, the camera will be able to “see” 
infrared light, e.g. at night, it increases light sensitivity. The 
image is shown in black & white when the IR cut filter is off. 
Set to Auto to automatically turn the filter off when the 
available visible light falls below the minimum requirement.

Note: There are different buttons in the Control Panel depending on the computer’s operating system but the 
descriptions and functionality are the same.
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Area Zoom
This allows you to draw a box over a desired area to zoom into. To activate, click the 
Center button described in the AMC viewer toolbar or in other Internet browsers choose 
PTZ > Center. Using your mouse click in the image and while holding down the left mouse 
button draw a square over the area you would like to zoom into.

Pan/Tilt/Zoom Controls
The Live View page also displays the Pan/Tilt/Zoom controls. The administrator 
can enable/disable the control for specified users under System Options > 
Security > Users > User List.

Pan/Tilt/Zoom Control Queue
The time the user is in control of the PTZ settings is limited and a queue of users has been 
set up. Use the buttons to request or release control of the Pan/Tilt/Zoom controllers. 

The AMC viewer toolbar (AXIS Media Control), available from Microsoft Internet 
Explorer, displays the following buttons:

The Play/Stop buttons start and stop the live video stream.

The Snapshot button takes a snapshot of the currently displayed image. The 
Snapshot function and the target directory for saving snapshots can be configured 
from AMC (AXIS Media Control), which is available from the Windows Control 
Panel (Internet Explorer only).
Click the View Full Screen button and the video image will fill the entire screen 
area. No other windows will be visible. Press Esc (Escape) on the computer 
keyboard to cancel full screen view.

Click-in-image movement
Click the Set emulated joystick mode button and click in the image to move the 
camera in the desired direction
Click the Center button and the camera view will center on the position that was 
clicked. The location to move to has a definite position, e.g. position x,y.
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The Pan/Tilt/Zoom Control Queue is set up by the administrator under:  
Dome Configuration > Advanced > Control Queue.

The Toolbar available from Mozilla Firefox, displays the following buttons:
The Play/Stop buttons start and stop the live video stream.

The Snapshot button takes a snapshot of the currently displayed image. The 
Snapshot function and the target directory for saving snapshots can be configured 
from AMC (AXIS Media Control), which is available from the Windows Control 
Panel (Internet Explorer only).
Click the View Full Screen button and the video image will fill the entire screen 
area. No other windows will be visible. Press Esc (Escape) on the computer 
keyboard to cancel full screen view.
Click the Set emulated joystick mode button and click in the image to move the 
camera in the desired direction
Click the Center button and the camera view will center on the position that was 
clicked. The location to move to has a definite position, e.g. position x,y.

AXIS 295 Video Surveillance Joystick
The AXIS 295 is a USB device that gives responsive and accurate control of the pan, tilt, 
zoom functionality. On installation, the joystick is automatically detected by AXIS Media 
Control where the 12 buttons can be programmed for a customized video surveillance 
system. For more information, please visit the Axis Website at http://www.axis.com
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Video Streams
The AXIS 233D provides several different image and video stream formats. The type to use 
depends on your requirements and on the properties of your network. 

The Live View page in the AXIS 233D provides access to Motion JPEG and MPEG-4 video 
streams, as well as to single JPEG images. Other applications and clients can also access 
these video streams/images directly, without going via the Live View page. 

Stream Types

Motion JPEG
This format uses standard JPEG still images in the video stream. These images are then 
displayed and updated at a rate sufficient to create a stream that shows constantly updated 
motion. 

The Motion JPEG stream uses more bandwidth, but also provides excellent image quality 
and access to each and every individual image contained in the stream.

Note also that multiple clients accessing Motion JPEG streams can use different image 
settings.

MPEG-4
This is a video compression standard that makes good use of bandwidth, and which can 
provide high quality video streams at less than 1 Mbit/s. 

Notes: • MPEG-4 is licensed technology. The AXIS 233D includes one viewing client license. Installing addi-
tional unlicensed copies of the viewing client is prohibited. To purchase additional licenses, contact 
your Axis reseller.

• All clients viewing the MPEG-4 stream must use the same image settings.

The MPEG-4 standard provides scope for a large range of different coding tools for use by 
various applications in different situations, and the AXIS 233D provides certain subsets of 
these tools. These are represented as Video object types, which are selected for use with 
different viewing clients. The supported video object types are:

• Simple - sets the coding type to H.263, as used by e.g. QuickTime™. 
• Advanced Simple - sets the coding type to MPEG-4 Part 2, as used by AMC (AXIS 

Media Control) 

When using MPEG-4 it is also possible to control the bit rate, which in turn allows the 
amount of bandwidth usage to be controlled. CBR (Constant Bit Rate) is used to achieve a 
specific bit rate by varying the quality of the MPEG-4 stream. When using VBR (Variable 
Bit Rate), the quality of the video stream is kept as constant as possible, at the cost of a 
varying bit rate. 
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MPEG-4 protocols and communication methods
To deliver live streaming video over IP networks, various combinations of transport 
protocols and broadcast methods are employed.

• RTP (Realtime Transport Protocol) is a protocol that allows programs to manage the 
real-time transmission of multimedia data, via unicast or multicast. 

• RTSP (Real Time Streaming Protocol) serves as a control protocol, to negotiate which 
transport protocol to use for the stream. RTSP is thus used by a viewing client to start a 
unicast session, see below.

• UDP (User Datagram Protocol) is a communications protocol that offers limited service 
for exchanging data in a network that uses the Internet Protocol (IP). UDP is an alterna-
tive to the Transmission Control Protocol (TCP). The advantage of UDP is that it is not 
required to deliver all data and may drop network packets when there is e.g. network 
congestion. This is suitable for live video, as there is no point in re-transmitting old 
information that will not be displayed anyway.

• Unicasting is communication between a single sender and a single receiver over a net-
work. This means that the video stream goes independently to each user, and each user 
gets their own stream. A benefit of unicasting is that if one stream fails, it only affects 
one user.

• Multicast is bandwidth-conserving technology that reduces bandwidth usage by simul-
taneously delivering a single stream of information to multiple network recipients. This 
technology is used primarily on delimited networks (intranets), as each user needs an 
uninterrupted data flow and should not rely on network routers.
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How to stream MPEG-4
Deciding on the combination of protocols and methods to use depends on your viewing 
requirements, and on the properties of your network.

RTP+RTSP 
This method (actually RTP over UDP and RTSP over TCP) should be your first consideration 
for live video, especially when it is important to always have an up-to-date video stream, 
even if some images do get dropped. This can be configured as multicast or unicast. 

Multicasting provides the most efficient usage of bandwidth, especially when there are 
large numbers of clients viewing simultaneously. Note however, that a multicast broadcast 
cannot pass a network router unless the router is configured to allow this. It is thus not 
possible to multicast over e.g. the Internet. 

Unicasting should be used for video-on-demand broadcasting. However, if more and more 
unicast clients connect simultaneously, the server will at some point become overloaded. 
There is also a maximum of 20 simultaneous viewers to be considered.

RTP/RTSP
This unicast method is RTP tunneled over RTSP. This can be used to exploit the fact that it 
is relatively simple to configure firewalls to allow RTSP traffic.

RTP/RTSP/HTTP or RTP/RTSP/HTTPS
These two methods can also be used to traverse firewalls. Firewalls are commonly 
configured to allow the HTTP protocol, thus allowing RTP to be tunneled.
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The AXIS Media Control 
The recommended method of accessing live video (MPEG-4 and/or Motion JPEG) from the 
AXIS 233D is to use the AXIS Media Control (AMC) in Microsoft Internet Explorer in 
Windows. This ActiveX component is automatically installed on first use, after which it 
can be configured by opening the AMC Control Panel applet from the Windows Control 
Panel. Alternatively, right-click the video image in Internet Explorer.

Other methods of accessing the video stream
Video/images from the AXIS 233D can also be accessed in the following ways:

• If supported by the client, the AXIS 233D can use Motion JPEG server push to display 
video. This option maintains an open HTTP connection to the browser and sends data as 
and when required, for as long as required. 

• As single JPEG images in a browser. Enter e.g. the path: 
http://<ip>/axis-cgi/jpg/image.cgi?resolution=CIF

• Windows Media Player. This requires AMC and the MPEG-4 decoder to be installed. The 
paths that can be used are listed below, in the order of preference.

• Unicast via RTP: axrtpu://<ip>/mpeg4/media.amp
• Unicast via RTSP: axrtsp://<ip>/mpeg4/media.amp
• Unicast via RTSP, tunneled via HTTP: axrtsphttp://<ip>/mpeg4/media.amp 
• Unicast via RTSP, tunneled via HTTPS: axrtsphttps://<ip>/mpeg4/media.amp 
• Multicast:  axrtpm://<ip>/mpeg4/media.amp

Other MPEG-4 clients

Although it may be possible to use other clients to view the MPEG-4 stream, this is not 
guaranteed by Axis. For some other clients, e.g. QuickTime™ the Video Object Type must 
be set to Simple, under Video & Image > Advanced > MPEG-4. It may also be necessary 
to adjust the advanced MPEG-4 settings.To assess the video stream from e.g. QuickTime™ 
the following path can be used:

rtsp://<ip>/mpeg4/media.amp 

This path is for all supported methods, and the client will negotiate with the network 
camera to determine exactly which transport protocol to use.

Notes: <ip> = IP address
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Configuring the Network Dome Camera
This section describes how to configure the AXIS 233D and is intended for the product 
Administrator who has unrestricted access to all Setup tools and Operator who has access 
to Video & Image, Live View Config and Event Configuration. See the section on Security, 
on page 39 for more information on user access control.

The AXIS 233D is configured under Setup from a standard browser.

Accessing the Setup Tools

Follow the instructions below to access the Setup Tools from a Web browser.

1. Start the Web browser and enter 
the IP address or domain name 
of the AXIS 233D in the 
location/address field.

2. The Live View page is now displayed. Click Setup to display the Setup configuration 
tools.

Overview of the Setup Tools
Setup Configuration
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Video & Image Settings
The following descriptions offer examples of the available features in the AXIS 233D. For 
details of each setting, please refer to the online help files which are available from each 
page. Click  to access the help files.

Image Settings
To optimize the video images according to your requirements, modify the following 
settings under Image Appearance. Each setting is described in the online help files 

All configuration of images and overlays will affect the performance of the network 
camera, depending on the usage and the available bandwidth.

• High resolution generates larger files
• Lower compression improves image quality, but generates larger files
• Black & White uses less bandwidth than Color
See also the specifications for frame rates and bandwidth in General performance 
considerations, on page 65. 
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Overlay Settings
Use these settings to include an image 
as an overlay, and/or the date and 
time, along with text of your own. 

Text overlays are all included on one 
line at the top or bottom of the video 
image. Use text overlays in 
combination with OSDI (On-Screen 
Directional Indicator) on page 31 to aid the viewer in navigating the camera. 

Example: 

To set up
PTZ coordinates in
text overlay.

To show the Preset and OSDI Zone name as text overlay use #P #L

Video Stream
The Maximum video stream time can be set as Unlimited, or a maximum stream time per 
session in seconds, minutes or hours can be defined. When the set time has expired, a new 
stream can be started by refreshing the page in the Web browser. Note that the maximum 
video stream time does not apply to clients connecting via multicast.

To avoid bandwidth problems on the network, the frame rate allowed to each viewer can 
also be limited. Select either Unlimited or define a maximum frame rate per viewer.

For a preview of the image and overlay settings before saving, click Test. When you are 
satisfied with the settings, click Save.

Please use the online help files for more information.

Overlay Image Settings
An overlay image is an image included in the video image. This might, for example, be 
your own company logo. Follow these instructions to upload and use an overlay image:

1. Go to Setup > Video & Image > Overlay Image. 

2. To upload the file (a logo or image) to the AXIS 233D, click the Browse button and 
locate it on your computer or server. 

3. Click the Upload button and follow the on-screen instructions.

4. The image is now available in the Use overlay image drop-down list.

5. Click Save.

6. Go to Setup > Video & Image and modify the parameters under Overlay Settings.

Date &
Time

Overlay

image
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Overlay image requirements Overlay image limitations
Image Formats Image Size

The height and width of the overlay 
image in pixels must be exactly 
divisible by 4.

Privacy Mask
Privacy masks allow you to mask areas in an image that are prohibited for the viewer. A 
3D mask, covers the area regardless of the camera’s angle or zoom position.

To set up a privacy mask:

1. Go to Setup > Video & Image > Privacy Mask and click on the Add button.

2. Move the camera’s view so that the area to be masked is at the center of the image.

3. Use zoom or change the Width and Height values to adjust size of the masked area.

4. Click Save.

Advanced Camera Settings
To optimize the lighting settings according to your requirements, modify the following 
settings under Lighting Conditions:

• Color level, Brightness and Sharpness- Find the level that best suits your image 
needs by testing.

• Exposure control - this setting is used to adapt to the amount/type of light being 
used. Allow slow shutter can be enabled/disabled when the exposure control is 
set to Automatic.

• Exposure area-This setting determines which part of the image will be used to 
calculate the exposure. 

• IR cut filter - when the IR cut filter is set to OFF, the camera will be able to ‘see’ 
infrared light, e.g. at night, thus making the image clearer. The image is shown in 
black & white when the IR cut filter is off. 
Note: If set to Auto, the camera will automatically switch between IR cut filter ON 
and OFF, according to the current lighting conditions. This is only possible when 
the iris is set to Auto Iris, and the exposure control is set to Automatic.

• Wide dynamic range - Corrects the exposure when the contrast is extreme 

• If the image overlay and text overlay are larger 
than the video image, no overlay will be dis-
played. When also using a text overlay, this 
will occupy 16 pixels in height and as many in 
width as the video image.

• If the overlay is initially positioned so that 
part of it is outside the video image, it will be 
relocated so that it appears over the video 
image, i.e. the entire image is always dis-
played.

• The maximum overlay image size supported by 
the AXIS 233D is the same as the maximum 
image resolution. See Technical Specifications, 
on page 46.

• Windows 24-bit BMP (full color)

• Windows 4-bit BMP (16 colors)

• OS/2 4-bit BMP (16 colors)
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between light and dark in an image. Test the different levels to find the one that 
works best of your light conditions.

• Backlight compensation - this setting is used to make the subject appear clearer, 
e.g. against a bright background.

Low Light Behavior
The settings for Low Light Behavior determine how the camera will behave at low light 
levels. These settings affect video image quality and frame rate. 

Exposure control  - This setting is used to adapt to the amount or type of light used. 
Automatic is the default setting and can be used in most situations. The shutter speed is 
automatically set to produce optimum image quality. Use Manual if you have special 
requirements for the exposure setting

Max exposure time - Increasing the exposure time will improve image quality, but at the 
expense of the total frame rate. There may also be an increase in motion blur.

Max gain - Measured in decibels (dB), the default value is 36 dB. A high level of 
amplification may provide a better image in very low light situations.

Shutter speed - A slower shutter speed in dark conditions will help to produce a brighter 
image, but will produce fewer frames per second which may cause images to be blurry 
during motion.

Please use the online help files for more information.

Image Settings
• Auto focus enabled (default setting).
• Stabilizer - When monitoring an environment that is subject to vibrations (i.e. 

traffic control) the images can appear to be unsteady. Choose the frequency (High 
or Low) that best applies to your environment to improve image quality.

• Image freeze on PTZ - Set this option to On to freeze the image during camera 
movement. Once the camera reaches its position the current image is shown. Auto 
freezes images only between preset positions. 
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MPEG-4 Settings

Tools for adjusting the MPEG-4 settings and for controlling the video bit rate. 

The MPEG-4 standard provides many different coding tools for various applications in 
different situations. As most MPEG-4 clients do not support all of these tools, it is usual to 
instead define and use subsets for different clients or groups of clients. These settings allow 
you to define the type of viewing client to use.

Adjusting the maximum bit rate and setting it to variable or constant is a good way of 
controlling the bandwidth used by the MPEG-4 video stream.

For more information on these advanced settings, please see the online help files
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Audio
The AXIS 233D can transmit audio to other clients by connecting an external microphone 
and can play audio received from other clients via a connected speaker.

Audio Settings
This section describes how to configure the basic audio settings for the AXIS 233D, e.g. set 
the communication mode and adjust the sound levels in the microphone and speaker 
connected to the camera. 

Enable Audio - Check this box to enable audio.

Audio Channels
The AXIS 233D has four types of audio transmission. Choose which type best suits your 
needs.

Audio mode
• Full duplex mode has simultaneous two-way audio, which means you can talk 

and listen at the same time.
• Half duplex mode transmits and receives audio in both directions, but only in one 

direction at a time. This means that you must select when to receive or transmit 
audio with the push-to-talk button. To speak, press and hold the button (check 
that the microphone is not muted). When finished speaking, release the button 
and you will receive audio from the other end of the connection.

Note: the push-to-talk button is configured from AMC. It is also possible to configure the push-to-talk button so 
that it toggles between speaking and listening modes.

• When selecting Simplex - Network Camera speaker only mode, the speaker con-
nected to the camera will play audio, but no audio will be transmitted from the 
camera to other web clients. This could be used to e.g. provide spoken instruc-
tions to a person seen in the camera. This mode requires you to use the 
push-to-talk button.

• Simplex - Network Camera microphone only mode transmits audio only from 
the AXIS 233D to web clients. It will not receive audio from any other web cli-
ents. This can be used in remote monitoring, web attractions etc., to provide live 
audio, as well as video, of a monitored situation.

When using half-duplex, the Send the sound from the active client to all other clients 
option transmits the audio signal from the client that is talking to all the other clients. 
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Audio Input

Audio from an external microphone or a line source can be connected to the Audio in 
Power/Audio connector of the AXIS 233D, see  I/O terminal connector blocks, on page 54. 
The audio source must be set to Microphone or Line depending on the connected device.

When Microphone is selected as a Source, set the Input sensitivity to High for an 
ordinary (unamplified) microphone, e.g. a computer mic or clip-on mic. Set to Low for a 
microphone with a built-in line amplifier.

The Enable microphone power option provides DC power for an external microphone. If 
using a small electret condenser microphone such as a clip-on or PC microphone, this 
option needs to be enabled. 

Note: To use a high impedance dynamic microphone, DC power should not be enabled. DC power will not harm 
the microphone, but if you are uncertain, try switching it off and on. The default value is DC power enabled. 
To use a professional microphone requiring 48V phantom power, you need an external power supply and 
must use a balanced-unbalanced converter (audio transformer) in between. 

If there are problems with the sound input being too low or high, adjust the input gain for 
the microphone attached to the AXIS 233D.

Select the desired audio Encoding format, G711, G726.

Depending on the selected encoding, set the desired audio quality (Bit rate). The settings 
depend on the available bandwidth and the required audio quality.

The AXIS 233D can be set to trigger an event if the incoming sound level rises above, falls 
below or passes the set value. The Alarm level is set between 0-100%. 

Audio Output

If the sound from the speaker is too low or high, adjust the output gain for the active 
speaker attached to the AXIS 233D.

When satisfied with the settings, click Save, or click Reset to revert to the previously saved 
settings.

Note: To receive synchronized video and audio, it is recommended that the time settings in the camera and client 
PC are synchronized with an NTP Server. This is enabled in the camera under System Options > Date & 
Time. Please refer to the help pages for more information.
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Advanced Audio
Advanced audio settings can improve audio quality by speech filtering and echo and noise 
cancellation.

When enabled the speech filter reduces noise by filtering out all the frequencies below 
100HZ and above 3500 Hz. This improves the sound quality if a person is close to the 
microphone when talking and will reduce background noises. 

Enable echo cancellation to reduce acoustic echoing that can be caused by audio coming 
from a speaker being captured by a microphone.

Noise cancelling is a way of reducing the background noise if the microphone, for 
example, is set up in a noisy environment and you are only interested in hearing a person 
who is talking close to the microphone. The noise canceller attenuation produces 
maximum noise reduction when set to 18dB of attenuation. Optimize the sound quality by 
listening to the sound and adjusting the attenuation level as required.
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Live View Config

Layout
These are the tools for deciding the layout 
of the Live View page. 

The layout can be set in 3 ways:

• Use Axis look - the layout is unchanged.
• Use custom settings - modify the default 

page with your own colors, images etc. 
Click the Configure button and see the 
following page.

• Own Home Page - Upload and use your 
own custom made page as the default 
web page. Click the Configure button 
and see the following page.

The other settings on this page concern 
which other features to include, e.g. buttons 
and links. See page 27 for more 
information.

Customizing the default page

The appearance of the default AXIS 
233D Live View page can be 
customized to suit your own 
requirements, or you can upload and 
use your own home page. To upload 
your own files, click the 
Upload/Remove button and see the 
description below.

Note that the setup address is:

 http://<ip address>/operator/basic.shtml
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Upload Own Web Files

Your own web files, background picture, color etc. must first be uploaded to the AXIS 
233D in order to be available for selection in the Custom Settings setup dialog. Once 
uploaded, the files are shown in the drop-down list.

1.Enter the path to the file, e.g. a file located on your workstation or click the 
Browse button.

2.Select the user level for the uploaded file. Setting the user access level means that 
you have complete control over which pages can be viewed by which users.

3.When the path is shown correctly in the text field, click the Upload button.

All uploaded files are shown in the list in the lower section of the page. To remove a file, 
check the box provided next to it and then click the Remove button.

• To use your uploaded file, click the radio button and select the file from the drop-down 
list by Own:

• To use an external file located somewhere other than in the AXIS 233D, click the radio 
button and enter the URL by External:

Own Home Page

To use a previously uploaded web page as the default page, check the checkbox, select the 
page from the drop-down list and click OK.

User Defined Links 

User defined links can be CGI links or web links. 
Once configured, the link(s) will appear on the Live 
View page.

To set up a web link, select the Use as web link radio 
button, enter a descriptive name and enter the URL in 
the provided field. Click Save and the link will 
appear on the Live View page. 

User defined CGI links can be used to issue HTTP API 
requests, e.g. PTZ commands. 

Example:

1. Check Show Custom Link 1

2. Enter a descriptive name, e.g. CAM START.

3. Select the Use as cgi link radio button and enter 
the cgi link in the field: 
http://192.168.0.125/axis-cgi/com/ptz.cgi?continuouspantiltmove=30,-30

User Defined Links
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4. Check Show Custom Link 2.

5. Enter a descriptive name, e.g. CAM STOP.

6. Select the Use as cgi link radio button and enter the cgi link in the field: 
http://192.168.0.125/axis-cgi/com/ptz.cgi?continuouspantiltmove=0,0

7. These links will appear in the web interface and can be used to control the AXIS 233D.

For more information on the Axis HTTP API, see the Support / Developer pages on the 
Axis Web site at http://www.axis.com.

Please use the online help files for more information.

For more information on the Axis HTTP API, see the Support / Developer pages on the 
Axis Web site at http://www.axis.com. See also the section on PTZ, on page 11.

Action Buttons

These buttons can be used to manually trigger and stop an event from the Live View page. 
The snapshot button allows you to take a snapshot of the video stream and save it to a 
computer.

Output Buttons

These buttons are used to control the outputs on the AXIS 233D and thus the equipment 
connected to them, e.g. to switch a light on or off:

• The Pulse button activates the port for a defined period
• Active/Inactive displays 2 buttons, one for each action (on/off)

Default Video Format

Select the default video format to use on the Live View page. Checking the box for Show 
video format selection displays a drop-down list on the Live View page allowing you to 
temporarily change the format. 

When using MPEG-4 as the video format, the default viewer is AXIS Media Control with 
Internet Explorer.

Note: It is also possible to view Motion JPEG when MPEG-4 is chosen as default and vice versa.
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Default Viewer

From the drop-down lists, select the default method for viewing video images for your 
browser. The camera will attempt to show the video images in the selected video format 
and viewer. If this is not possible, the camera will override the settings and select the best 
available combination.

AMC Recommended viewer in Windows Internet Explorer (MPEG-4 /Motion JPEG).

QuickTime MPEG-4 only.

Java applet A slower imaging alternative to AMC. Requires one of the following installed on the client:

Still image Displays still images only. Hit the Refresh button in your browser to view a new image.

Server Push Recommended viewer for other browsers (Motion JPEG).

QuickTime MPEG-4 only.

Java applet A slower imaging alternative to Server Push (Motion JPEG only).

Still image Displays still images only. Hit the Refresh button in your browser to view a new image.

Viewer Settings

Checking the Show viewer toolbar box displays the toolbar under the video stream. 

By checking the Enable MPEG-4 decoder installation box, it is also possible for the 
Administrator to enable or disable the installation of the MPEG-4 decoder. This is used to 
prevent the installation of unlicensed copies. Further decoder licenses can be purchased 
from your Axis dealer.

Check the Show crosshair in PTZ joystick mode checkbox to indicate the center of the 
image when viewing the video stream in PTZ joystick mode.

Enable recording button - allows the viewer to start a recording at any time by clicking on 
the record button.

HTML Examples

You can add live video from the AXIS 233D to your own web site. The camera can 
transmit a Motion JPEG stream to up to 20 simultaneous connections, although an 
administrator can restrict this to fewer. If MPEG-4 is set as video format, multicasting is 
used and the audio and video stream will be available for an unlimited number of viewers 
connected to the parts of the network where multicast is enabled. Please note that a 
separate MPEG-4 license is required for each viewer.

Select the preferred Video Format from the drop down list. The available options are 
Motion JPEG, MPEG-4 using AMC and MPEG-4 using QuickTime.

Browser Viewer Description

Windows 
Internet Explorer • JVM (J2SE) 1.4.2 or higher

• JRE (J2SE) 5.0 or higher

Other browsers
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The Motion JPEG selection has additional settings for Image Type, Image size and other 
optional settings to configure the video stream to suit your Web page.  
Click Update once satisfied. 

The camera generates the required source code for your configuration. Copy this code and 
paste it into your own Web page code.

External Video

An external video source is a source originating from some other Axis device on the 
network. The images from these sources can be displayed just as if they were produced by 
the AXIS 233D.

The External Video Source list shows all of the external video sources currently 
configured. The information displayed is the source's name and the path to the video 
stream. Up to 20 external video sources can be configured.

Working with External Video Sources
1. To add a new video source, click the Add button. This opens the External Video 

Source Setup dialog, which is used to make all the necessary settings.

2. To modify an existing video source, select it and click the Modify button.

3. To delete an external video source, select it and click the Remove button.

Sequence Mode

Sequence Mode is a configuration that automatically displays the view from multiple, 
previously defined Preset Positions (see Dome Configuration, on page 31 and the online 
help).

This is useful for e.g. security personnel viewing a surveillance system that constantly 
rotates through the selected preset positions, in the listed order, or randomly. 

To set up sequence mode, simply select the desired preset positions and enter the number 
of seconds or minutes to display each position for. Each position can be displayed for up to 
59 minutes.
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Dome Configuration

Preset Positions

A preset position is a pre-defined camera view than can be used to quickly move the 
camera to a specific location.

From Preset Position Setup, use the Pan, Tilt and Zoom (PTZ) controls to steer the camera 
to the required position. When satisfied with the camera's position, enter a descriptive 
name. The camera position, iris and focus settings are then saved as a preset position. 

The position can be assumed at any time, 
by selecting the preset's name from the 
Preset positions drop-down list. Preset 
positions can be selected in Live View, 
from events, in Sequence mode and in 
the Guard Tour.

One position can be set as the Home 
position, which is readily accessible by 
clicking on the H button in both the Preset 
Position Setup window and the Live View 
window. The position's name will have (H) 
added, e.g. Office Entrance (H).

Include the preset position name in the overlay text. See  Overlay Settings, on page 19.

Guard Tour
A guard tour displays the different preset positions, one-by-one, in a pre-determined order 
or randomly, and for configurable time periods. Once the preset position has been set, and 
added to the guard tour, the following settings can be made:

• View Time in seconds or minutes 
• Move Speed - sets the speed of the Pan/Tilt movements to the preset position
• View Order (or Random)

OSDI Zones
On-screen Direction Indicator Zones are areas that you define with coordinates and a 
descriptive name. These zones can then be included in the Image text to aid the viewer in 
navigating the camera.
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The camera uses the coordinates of the center of the image to set the lower left and upper 
right zone areas. First navigate where you would like the most lower left point of the OSDI 
Zone to be located. By clicking on the Get button the coordinates are set. Proceed to where 
the upper right point of the zone should be located and click on its Get button. Give the 
zone a descriptive name and go to Overlay Settings, on page 19 for information about 
including the name of OSDI Zone in the Image text.

Advanced
Limits -Define the pan, tilt, zoom and focus limits for the AXIS 233D. Movements to the 
left and right, up and down can be restricted to narrow the area under surveillance. The 
near focus limit can be set to avoid focusing on objects too close to the camera.

Note: Once a limit has been saved, this position can not be exceeded by the AXIS 233D unless the values have 
been reset and saved to a greater value first (i.e. reset the default values of the mechanical restrictions).

Move speed sets the speed of the camera's Pan/Tilt movements. The default setting is 
maximum speed.

E-flip - This flips the image automatically when the target moves, for example, under the 
camera and then moves on. In situations where E-flip is not desired set the Lower limit to 
-90 ° , which will turn off this function.

Ctrl Panel - Shortcut command buttons can be created to provide direct access to various 
commands provided by the AXIS 233D. The buttons are then displayed in the PTZ Panel 
which is available on the Live View page by clicking Ctrl Panel (see page 10). AXIS VAPIX 
gives you the possibility to create your own commands. For more information go to 
www.axis.com

Control Queue - The administrator can set up a queue for the PTZ controllers. Once set up, 
the PTZ Control Queue buttons will appear on the Live View page offering one viewer 
exclusive control for a limited amount of time. Other users will be placed in the queue.

PTZ Control Queue on Live View page

 

Please use the online help files for more information.
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Event Configuration
This section describes how to configure the AXIS 233D for alarm handling. The AXIS 233D 
can be configured to perform certain actions when certain types of events occur.

Event type A set of parameters describing how and when the Network Dome Camera is to perform certain actions

the circumstances that start an event e.g. at a signal from an external device, such as a door switch or 
a motion sensor

Scheduled Event page 36 the circumstances that start an event e.g. at a pre-programmed time

Action what occurs when the event triggers e.g. uploaded video images to an FTP server, email notification, 
etc.

Event Servers

Event Servers are used, e.g. for receiving uploaded image files and/or notification 
messages. To set up Event server connections in your AXIS 233D, go to Setup > Event 
Configuration > Event Servers and enter the required information according to the 
selected server type.

Server type Purpose Requires information

HTTP Server

TCP Server

For details on each setting, please refer to the online help files  which are available 
from each web page.

Note: Pre-trigger and Post-trigger buffers will be lost if the connection to the event server fails.

When the setup is complete, the connection can be tested by clicking the Test button (the 
connection test will take approximately 10 seconds). 

Triggered Event page 34

FTP Server • used for uploading saved images • Descriptive name of your choice
• User Name and Password (to FTP server)
• Upload path e.g. images/
• Port number e.g. port 21
• Use passive mode if there is a firewall between 

the AXIS 233D and the FTP server
• used for notification messages
• used for uploading saved images

• Descriptive name of your choice
• URL
• User Name and Password (to HTTP server)
• Proxy address/Proxy port (if required)
• Proxy User Name and Password (if required)

• used for notification messages • Descriptive name of your choice
• User Name and Password (to TCP server)
• Port number e.g. port 80
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Event Types
An Event Type is a set of 
parameters describing how and 
when the Network Dome Camera is 
to perform certain actions.

Example: If a door is opened, and an event 
has been configured to act on this, the Network 
Dome Camera can e.g. record and save video 
images to an FTP server or send a notification 
email to a pre-configured email address with a 
pre-configured message. Video images can be 
sent as an attachment with the email.

Triggered Event
A Triggered event is activated from, e.g:

• a switch (doorbell) connected to an input port on the Network Dome Camera
• lost signal from the camera
• a manually activated action e.g. from an action button in the web interface
• on restart (reboot) after e.g. power loss

How to set up a triggered event
This example describes how to set the Network Dome Camera to upload images when the 
main door is opened:

1. Click Add triggered on the Event types page.

2. Enter a descriptive name for the event, e.g. Main door.

3. Set the priority - High, Normal or Low (see online help files).

4. Set the Respond to Trigger... parameters when the event is to be active, 
e.g. only after office hours

5. Select the trigger alternative from the Triggered by... drop-down list, e.g. an Input 
port with a connected sensor if the door is opened.

6. Set the When Triggered... parameters i.e. set what the Network Dome Camera is to 
do if the main door is opened e.g. upload images to an FTP server.

7. Click OK to save the Event in the Event Types list.

 

Please use the online help files for descriptions of each available option.
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Pre-trigger and Post-trigger buffers
This function is very useful when checking to see what happened immediately before and 
after a trigger, e.g. 2 minutes before and after a door has been opened. 

Go to Event Types > Add Triggered... > 
When Triggered... and check the Upload 
images checkbox to expand the web page 
with the available options.

Buffer size - up to 36 MB buffer. The 
maximum length of time of the 
pre-/post-buffer depends on the image 
size and selected frame rate.

Include pre-trigger buffer - images stored 
internally in the server from the time 
immediately preceding the trigger. Check 
the box to enable the pre-trigger buffer, 
enter the desired length of time and 
specify the required image frequency.

Include post-trigger buffer - contains images from the time immediately after the trigger. 
Configure as for pre-trigger.

Note: If the pre- or post-buffer is too large for the internal memory, the frame rate will be reduced and individual 
images may be missing. If this occurs, an entry will be created in the unit's log file.

Continue image upload (unbuffered) - enable the upload of images for a fixed length of 
time. Specify the length of time for the uploaded recording, in seconds, minutes or hours, 
or for as long as the trigger is active. Finally, set the desired image frequency to the 
maximum (the maximum available) or to a specified frame rate. The frame rate will be the 
best possible, but might not be as high as specified, especially if uploading via a slow 
connection.
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Scheduled Event
A Scheduled event can be activated at pre-set times, in a repeating pattern on selected 
weekdays.

How to set up a scheduled event
This example describes how to set the Network Dome Camera to send an email notification 
with saved images from at a set time:

1. Click Add scheduled on the Event types page.

2. Enter a descriptive name for the event, 
e.g. Scheduled email.

3. Set the priority (High, Normal or Low).

4. Set the Activation Time parameters 
(24h clock) when the event is to be 
active, e.g. start on Fridays at 18.00 
with a duration of 62 hours.

5. Set the When Activated... parameters 
i.e. set what the Network Dome Camera 
is to do at the specified time e.g. send 
uploaded images to an email address.

6. Click OK to save the Event in the Event 
Types list.

Please use the online help files for descriptions of each available option.
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Motion Detection
Motion detection is used to generate an alarm whenever movement occurs (or stops) in the 
video image. A total of 10 Include and/or Exclude windows can be configured.

• Included windows target specific areas within the whole video image
• Excluded windows define areas within an Include window that should be ignored 

(areas outside Include windows are automatically ignored)
Once configured, the motion detection windows will appear in the list of available triggers, 
for triggering events. See How to set up a triggered event above.

Note: Using the motion detection feature may decrease the camera’s overall performance.

Configuring Motion Detection

1. Click Motion Detection in the Event Configuration menu.

2. Click the Configure Included Window radio button and click New.

3. Enter a descriptive name under Window name.

4. Adjust the size (drag the bottom right-hand corner) and position (click on the text 
at the top and drag to the desired position).

5. Adjust the Object size, History and Sensitivity profile sliders (see table below for 
details). Any detected motion within an active window is then indicated by red 
peaks in the Activity window (the active window has a red frame).

6. Click Save.

To exclude parts of the Include window, click the Configure Excluded Windows button 
and position the Exclude window as required, within the Include window.
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Please see the online help for descriptions of each available option.

High level Only very large objects 
trigger motion detection

An object that appears in the region will 
trigger the motion detection for a long 
period

Ordinary colored objects on ordinary 
backgrounds will trigger the motion 
detection

Low level Even very small objects 
trigger motion detection

An object that appears in the region will 
trigger motion detection for only a very 
short period

Only very bright objects on a dark back-
ground will trigger motion detection

Default value Low Medium to High Medium to High

Examples: 

• Avoid triggering on small objects in the video image by setting the object size level to high.
• To reduce the number of triggers if there is a lot of movement during a short period of time, select a high 

history level.
• To only detect flashing light, low sensitivity can be selected. In other cases, a high sensitivity level is 

recommended.

Port Status

Under Event Configuration > Port Status there is a list that shows the status for the 
connected inputs and outputs of the AXIS 233D for the benefit of the Operator who cannot 
access the System Options section.

Example: If the Normal state for a push button (e.g. doorbell) connected to an input is set to Open circuit - as 
long as the button is not pushed, the state is inactive. If the push button is pushed, the state of the input 
changes to active.

 Object Size History Sensitivity
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System Options

Security
User access control is enabled by default, the administrator sets the root password on first 
access. Other users are authorized with user names and passwords, or the administrator can 
choose to allow anonymous viewer login to the Live View page, as described below:

Users - the user list displays the authorized users and access levels:

User Description

Viewer Provides the lowest level of access, which only allows the user access to the Live View page.

Operator An Operator can view the Live View page, create and modify event types and adjust certain other 
settings. The Operator does not have access to the Systems Options configuration pages.

Administrator An administrator has unrestricted access to the Setup Tools and can determine the registration of all 
other users. 

User Settings - check the corresponding checkboxes to enable:

• Anonymous viewer login - allows any viewer direct access to the Live View 
page.

• Maximum number of simultaneous viewers - enter a value here to restrict the 
number of Motion JPEG and MPEG-4 viewers accessing the unit. This is useful if 
you need to save on bandwidth. Note that within the limit of 20 users, all multi-
cast viewers count as 1 viewer.

• Anonymous PTZ control login - allows any viewer access to the Pan/Tilt/Zoom 
controllers on the Live View page.

IP Address Filtering 

Enable IP Address Filtering to allow or deny access to the AXIS 233D. Once enabled, the 
IP addresses in the list will be allowed or denied access according to the choice made in the 
drop-down list Allow/Deny the following IP addresses. 

The administrator can add up to 256 IP address entries to the list (a single entry can 
contain multiple IP addresses). The users from these IP addresses need to be specified in the 
user list with the appropriate access rights. This is done from Setup > System Options > 
Security > Users. 

Referrals 

To prevent unauthorized clients from including the video stream from the cameras into 
external Web pages, check the Referrals checkbox and enter the IP address or Host name 
of the computer that hosts the Web pages with the included video stream. Several IP 
addresses/host names can be defined and are separated by semicolons (;). This option is 
only applicable to Motion JPEG video streams.
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Notes: If the referrals feature is enabled and you wish to also allow normal access to the Live View page, the 
product's own IP address or host name must be added to the list of allowed referrers.

Restricting referrers has no effect on an MPEG-4 video stream. To restrict an MPEG-4 stream, IP address 
filtering must be enabled.

Restricting referrers is of greatest value when not using IP address filtering. If IP address filtering is used, 
then the allowed referrers are automatically restricted to those allowed IP addresses.

HTTPS

For greater security, the AXIS 233D can be configured to use HTTPS (Hypertext Transfer 
Protocol over SSL (Secure Socket Layer)). That is, all communication that would otherwise 
go via HTTP will instead go via an encrypted HTTPS connection.

Certificate - to use HTTPS for communication with the AXIS 233D, a Certificate must be 
created using one of the following methods:

• A self-signed certificate can be created in the network camera, but this does not guar-
antee the same level of security as an official certificate.

• An official certificate issued by a CA (Certificate Authority). A CA issues and manages 
security credentials and public keys for message encryption.

1. Click either Create self-signed certificate or Create Certificate Request and enter 
the required information in the provided fields.

2. Click OK.

3. Create self-signed certificate generates and installs a certificate which will be 
displayed under Installed Certificate. 
Create Certificate Request generates a PEM formatted request which you copy and 
send to a CA for signing. When the signed certificate is returned, click Install signed 
certificate... to install the certificate in the AXIS 233D.

4. Set the HTTPS Connection Policy for the administrator, Operator and Viewer to 
enable HTTPS connection (set to HTTP by default)

Please refer to the home page of your preferred CA for information on where to send the 
request etc. For more information, please refer to the online help files

802.1X - Network Admission Control

IEEE 802.1X is an IEEE standard for port-based Network Admission Control. It provides 
authentication to devices attached to a network port (wired or wireless), establishing a 
point-to-point connection, or, if authentication fails, preventing access on that port. 
802.1X is based on EAP (Extensible Authentication Protocol). 

In a 802.1X enabled network switch, clients equipped with the correct software can be 
authenticated and allowed or denied network access at the Ethernet level. 
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Clients and servers in an 802.1X network may need to authenticate each other by some 
means. In the Axis implementation this is done with the help of digital certificates 
provided by a Certification Authority. These are then validated by a third-party entity, 
such as a RADIUS server, examples of which are Free Radius and Microsoft Internet 
Authentication Service.

To perform the authentication, the RADIUS server uses various EAP methods/protocols, of 
which there are many. The one used in the Axis implementation is EAP-TLS 
(EAP-Transport Layer Security). 

The AXIS network video device presents its certificate to the network switch, which in turn 
forwards this to the RADIUS server. The RADIUS server validates or rejects the certificate 
and responds to the switch, and sends its own certificate to the client for validation. The 
switch then allows or denies network access accordingly, on a pre-configured port. 

The authentication process

1. A CA server provides the required signed certificates.

2. The Axis video device requests access to the protected network at the network 
switch. The switch forwards the video device’s CA certificate to the RADIUS 
server, which then replies to the switch.

3. The switch forwards the RADIUS server’s CA certificate to the video device, which 
also replies to the switch. 

4. The switch keeps track of all responses to the validation requests. If all certificates 
are validated, the Axis video device is allowed access to the protected network via 
a pre-configured port.

RADIUS (Remote Authentication Dial In User Service) - AAA (Authentication, 
Authorization and Accounting) protocol for applications such as network access or IP 
mobility. It is intended to work in both local and roaming situations.

CA servers - In cryptography, a Certification Authority (CA) is an entity that provides 
signed digital certificates for use by other parties, thus acting a trusted third party. There 
are many commercial CA’s that charge for their services. Institutions and governments 
may have their own CA, and there are free CA’s available. 

Date & Time

Current Server Time  - displays the current date and time (24h clock). The time can be 
displayed in 12h clock format in the Overlay Images (see below).

New Server Time  - Select your time zone from the drop-down list and check the daylight 
saving time changes, if desired. 
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From the Time Mode section, select the preferred method to use for setting the time:

• Synchronize with computer time - sets the time from the clock on your com-
puter. 

• Synchronize with NTP Server - the network camera will obtain the time from an 
NTP server every 60 minutes. Specify the NTP server's IP address or host name.

Note: Note that if using a host name for the NTP server, a DNS server must be configured under TCP/IP settings. 
See Network > Advanced TCP/IP Settings below.

• Set manually - this option allows you to manually set the time and date.

Date & Time Format Used in Images  - specify the formats for the date and time (12h or 
24h) displayed in the Live View video streams.

Use the predefined formats or use your own custom date and time formats. See Advanced 
File Naming & Date/Time Formats in the help files for information on how to create 
your own file formats.
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Network - Basic TCP/IP Settings

IP Address Configuration

The AXIS 233D supports both IP version 4 and IP version 6. Both versions may be enabled 
simultaneously, and at least one version must always be enabled. 

When using IPv4, the IP address for the AXIS 233D can be set automatically via DHCP, or 
a static IP address can be set manually. 

If IPv6 is enabled, the AXIS 233D will receive an IP address according to the configuration 
in the network router.

There are also options for setting up notification of changes in the IP address, and for 
using the AXIS Internet Dynamic DNS Service. For more information on setting the IP 
address, please see the online help.

Notes: • DHCP is a protocol for automatic IP address assignment on a network. IP address assignment via DHCP 
may lead to the situation where the IP address changes and you lose contact. Configure the options for 
notification of IP address change (under Services) to receive notification from the network camera when 
the IP address changes.

• Alternatively, if your DHCP server can update a DNS server, you can access the AXIS 233D by host name 
which is always the same, regardless of the IP address.

For more information, please refer to the online help files

 

Services

Enable ARP/Ping setting of IP address - The IP address can be set using the ARP/Ping 
method, which associates the unit's MAC address with an IP address. Check this box to 
enable the service. Leave disabled to prevent unintentional resetting of the IP address.

Notes: • The ARP/Ping service is automatically disabled 2 minutes after the unit is started, or as soon as an IP address 
is set.

• Pinging the unit will still be possible when this service is disabled.

Options for notification of IP address change - If the IP address for the camera changes, 
e.g. automatically by DHCP, you can choose to be notified of the change. Click Settings... 
and enter the required information.

AXIS Internet Dynamic DNS Service - Use the AXIS Internet Dynamic DNS service to 
assign a host name for easy access to your AXIS 233D (requires Internet access). 

Click Settings... to register the camera with the Axis Internet Dynamic DNS service, or to 
modify the existing settings (requires access to the Internet). The domain name currently 
registered at the Axis Internet Dynamic DNS service for your product can at any time be 
removed.
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Network - Advanced TCP/IP Settings

DNS Configuration

DNS (Domain Name Service) provides the translation of host names to IP addresses on 
your network.

Obtain DNS server address via DHCP - automatically use the DNS server settings provided 
by the DHCP server. Click the View button to see the current settings.

Use the following DNS server address - enter the desired DNS server by specifying the 
following:

Domain name - enter the domain(s) to search for the host name used by the AXIS 233D. 
Multiple domains can be separated by semicolons (;). The host name is always the first part 
of a Fully Qualified Domain Name, e.g. myserver is the host name in the Fully Qualified 
Domain Name myserver.mycompany.com where mycompany.com is the Domain name.

DNS servers - enter the IP addresses of the primary and secondary DNS servers.

NTP Configuration

Obtain NTP server address via DHCP - check this radio button to automatically look up 
and use the NTP server settings as provided by DHCP. Click the View button to see the 
current settings.

Use the following NTP server address - to make manual settings, check this radio button 
and enter the host name or IP address of the NTP server.

Host Name Configuration

The AXIS 233D can be accessed using a host name, instead of an IP address. The host 
name is usually the same as the assigned DNS Name. It is always the first part of a Fully 
Qualified Domain Name and is always one word, with no period. For example, myserver is 
the host name in the Fully Qualified Domain Name myserver.mycompany.com.

The enable dynamic DNS updates allows you to alias a dynamic IP address to a static host 
name, allowing your computer to be more easily accessed from various locations on the 
Internet. Outside users can always access your server using the associated DNS name 
regardless of the WAN IP. The DNS server used by the user and/or the DNS server 
responsible for the domain in use must support RFC2136 and allow updates from the AXIS 
233D.

The TTL (Time To Live) value determines how long (in seconds) the reply from the DNS 
server should be remembered when checking that the domain name for the registered IP 
address is still valid. For more information, please see the online help
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Link-Local IPv4 Address

This is enabled by default and assigns the AXIS 233D an additional IP address for use with 
UPnP™. The AXIS 233D can have both a Link-Local IP and a static/DHCP-supplied IP 
address at the same time - these will not affect each other.

HTTP 

The default HTTP port number (80) can be changed to any port within the range 1 - 65535. 
This is useful for e.g. simple port mapping.

HTTPS 

If applicable, enter the HTTPS port the AXIS 233D will use. The default setting (443) can be 
changed to any port within the range 1024-65535. HTTPS is used to provide encrypted 
web browsing.

NAT traversal (port mapping)

A broadband router allows devices on a private network (LAN) to share a single connection 
to the Internet. This is done by forwarding network traffic from the private network to the 
“outside” i.e. the Internet. Security on the private network (LAN) is increased since most 
broadband routers are pre-configured to stop any attempts to access the private network 
(LAN) from the public network/Internet.

Use NAT traversal when your AXIS 233D is located on an intranet (LAN) and you wish to 
make it available from the other (WAN) side of a NAT router. With NAT traversal properly 
configured, all HTTP traffic to an external HTTP port in the NAT router will be forwarded 
to the camera.

LAN (intranet) WAN (Internet)

Broadband 
(NAT)
router ISP

Notes: • For NAT traversal to work, this must also be supported by the broadband router.

• The broadband router has many different names: “NAT router”, “Network router“, Internet 
Gateway”, “Broadband sharing device” or “Home firewall” but the essential purpose of the 
device is the same.
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Enable/Disable - When enabled, the AXIS 233D will attempt to configure port mapping in 
a NAT router on your network, using UPnP™. Note that UPnP™ must be enabled in the 
camera (see System Options > Network > UPnP).

AXIS Internet Dynamic DNS Service - Use this free service to assign a host name 
(user-friendly name) for easy access to your camera. If the IP address of the camera or NAT 
router changes, the AXIS Internet Dynamic DNS Service will automatically be updated 
with the new IP address.

Use manually selected NAT router - Select this option to manually select a NAT router 
and enter the IP address for the router in the field provided.

If a router is not manually specified, the AXIS 233D will automatically search for NAT 
routers on your network. If more than one router is found, the default router will be 
selected.

Alternative HTTP port - Select this option to manually define an external HTTP port. Enter 
the port number in the field provided. If no port is entered here a port number will 
automatically be selected when NAT traversal is enabled. 

Notes: •An alternative HTTP port can be used/be active even if NAT traversal is disabled. This is useful if 
e.g. your NAT router does not support UPnP and you need to manually configure port forward-
ing in the NAT router.

•If a manually selected port is already in use, another will automatically be selected.

•When the port is selected automatically it will be displayed in this field. This can be changed by 
entering a new port number and clicking Save.

FTP

The FTP server running in the AXIS 233D enables the upload of e.g. new firmware, user 
applications, etc. Check the box to enable the service.

RTSP

The RTSP protocol allows a connecting client to start an MPEG-4 stream. Check the box to 
enable the service and enter the RTSP port number to use. The default setting (554) can be 
changed to any port within the range 1024-65535.

Network Traffic

Connection Type - The default setting is Auto-negotiate, which means that the correct 
speed is automatically selected. If necessary, you can set the connection speed by selecting 
it from the drop-down list.
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SOCKS
SOCKS is a networking proxy protocol. The AXIS 233D can be configured to use a SOCKS 
server to reach networks on the other side of a firewall/proxy server. This functionality is 
useful if the AXIS 233D is located on a local network behind a firewall, but notifications, 
uploads, alarms, etc., need to be sent to a destination outside the local network (e.g. to the 
Internet).

QoS (Quality of service)
Quality of Service (QoS) provides the means to guarantee a certain level of a specified 
resource to selected traffic on a network. Quality can be defined as e.g. a maintained level 
of bandwidth, low latency, no packet losses, etc. The main benefits of a QoS-aware 
network can be summarized as:

•The ability to prioritize traffic and thus allow critical flows to be served before flows with 
lesser priority.
•Greater reliability in the network, thanks to the control of the amount of bandwidth an 
application may use, and thus control over bandwidth races between applications.
The QoS in Axis network video products marks the data packets for various types of 
network traffic originating from the product. This makes it possible for network routers 
and switches to e.g. reserve a fixed amount of bandwidth for these types of traffic. The 
types of traffic marked by the camera are video, audio, event/alarm and management 
network traffic.

QoS Settings

For each type of network traffic supported by your Axis network video product, enter a 
DSCP (Differentiated Services Codepoint) value. This value is used to mark the traffic’s IP 
header. When the marked traffic reaches a network router or switch, the DSCP value in the 
IP header tells the router or switch which type of treatment to apply to this type of traffic, 
for example, how much bandwidth to reserve for it.

Note that DSCP values can be entered in decimal or hex form, but saved values are always 
shown in decimal. For more information on Quality of Service, please see the Axis support 
web at www.axis.com/techsup

SMTP (email)
Enter the host names or addresses for your primary and secondary mail servers in the fields 
provided, to enable the sending of notifications and image/video email messages from the 
camera to predefined addresses via SMTP.

If your mail server requires authentication, check the box for Use authentication to log in 
to this server and enter the necessary information.
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SNMP
The Simple Network Management Protocol (SNMP) allows remote management of network 
devices. Depending on the level of security required, select the version of SNMP to use. The 
three levels of security are:

• SNMP V1 - includes no security.
• SNMP V2c - uses very simple security. The community name can be specified as a pass-

word for read or read/write access to all supported SNMP objects. The community is the 
group of network devices using SNMP.

• SNMP V3 - provides encryption and secure passwords. HTTPS must be enabled.

UPnP™
The camera includes support for UPnP™, which is enabled by default. If also enabled on 
your computer, the camera will automatically be detected and a new icon will be added to 
“My Network Places.” 

Note: UPnP must also be enabled on your Windows XP or ME computer. To do this, open the Control Panel from 
the Start Menu and select Add/Remove Programs. Select Add/Remove Windows Components and open 
the Networking Services section. Click Details and then select UPnP as the service to add.

RTP / MPEG-4
These settings are the port range, IP address, port number (video and audio), and 
Time-To-Live value to use for video and audio in multicast MPEG-4 format. Only certain 
IP addresses and port numbers should be used for multicast streams. For more information, 
please see the online help.

Bonjour
The AXIS 233D includes support for Bonjour. When enabled, the camera is automatically 
detected by operating systems and clients that support this.

Ports & devices
I/O Ports  - The pinout, interface support and the control and monitoring functions are 
described in the section on the I/O terminal connector blocks, on page 54.

Maintenance
• Restart - The unit is restarted without changing any of the settings. Use this method if 

the unit is not behaving as expected.
• Restore - The unit is restarted and most current settings are reset to factory default val-

ues. The settings that will not be reset are as follows:
• the boot protocol (DHCP or static)
• the static IP address
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• the default router
• the subnet mask
• the system time

• Default - The default button should be used with caution. Pressing this will return all of 
the network camera's settings to the factory default values (including the IP address).

Dome Status - Click the Test button to check the camera and dome mechanics for errors. 
Contact Axis Customer Services if you receive an error message as the result of this test.

Upgrade Server - See Support, on page 50.

Backup - To take a backup of all of the parameters, and any user-defined scripts, click this 
button. If necessary, it is then possible to return to a previous configuration if settings are 
changed and there is unexpected behavior.

Restore - click the Browse button to locate the saved backup file (see above) and then click 
the Restore button. The settings will be restored to the previous configuration.

Note: Backup and Restore can only be used on the same unit running the same firmware. This feature is not 
intended for multi-configurations or for firmware upgrades.
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Support
The support overview page provides valuable information on troubleshooting and contact 
information, should you require technical assistance.

System Overview - is a quick look over the camera’s status and settings. Information that 
can be found here includes the camera’s Firmware version, IP address, Security, Optional 
Network Services, Event Settings, Image settings and Recent log items. Many of the 
captions are also links to the proper Setup page to conveniently make adjustments in the 
camera’s settings. 

Logs & Reports 

When contacting Axis support, please be sure to provide a valid Server Report with your 
query.

View Information - The Log report and the Parameter List also provide valuable 
information for troubleshooting and when contacting Axis’ support service.

Configuration:
Log Level for Log Files - from the drop-down list, select the level of information to be 
added to the Log file

Log Level for Email - from the drop-down list, select the level of information to send as 
email and enter the destination email address.

Advanced
Scripting is an advanced function that provides the possibility to customize and use 
scripts. This function is a very powerful tool. 

Caution!
Improper use may cause unexpected behavior or even cause loss of contact with the 
unit. If a script does cause problems, reset the unit to its factory default settings. A 
backup file may be of use to return the unit to its latest configuration). 
 
Axis strongly recommends that you do not use this function unless you fully 
understand the consequences. Note that Axis support does not provide assistance for 
problems with customized scripts. 

For more information, please visit the Developer pages at www.axis.com/developer

Plain Config - this function is for the advanced user with experience of Axis network 
camera configuration. All parameters can be set and modified from this page. Help is 
available from the standard help pages.
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About
Third Party Software Licenses - click View licenses for a list of the licensed software used 
in the AXIS 233D Network Dome Camera.

 

Resetting to Factory Default Settings
To reset the AXIS 233D to the original default settings, go to the System Options > 
Maintenance web page (described in Maintenance, on page 48) or use the control button 
on the AXIS 233D as described below

Red Restart Button

Status LED Indicator

Black Control Button

:

Resetting to the Factory Default Settings

This will reset all parameters, including the IP address, to the Factory Default settings:

1. Remove dome of camera. See Installation Guide for instructions.

2. Press and hold the red and black  button at the same time. Release the red restart button, but continue 
to hold down the black control button.

3. Keep the black control button pressed until the status indicator flashes amber (this may take up to 15 
seconds).

4. Release the black control button.

5. When the status indicator displays green (which can take up to 1 minute) the process is complete and 
the camera has been reset to factory default.

6. Re-assign the IP address in the AXIS 233D using one of the methods described in this document.
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I/O terminal Connectors
The AXIS 233D Network Dome Camera has 3 (8 pin) connectors. The inputs/outputs are 
used in applications for, e.g. event triggering, time lapse recording, alarm notification via 
email, picture storage to FTP locations

Network 
connector

Inputs
Power/Audio Outputs

.

• Power, auxiliary power, GND and audio.
• 4 solid state relay outputs - These can drive a maximum load of 50V DC at 

500mA directly or heavier loads by connecting additional relay circuitry. If the 
output is used with an external relay, a diode must be connected in parallel with 
the load for protection against voltage transients.

• 4 alarm inputs - Used for connecting external alarm devices and triggering 
images for specific alarm-based events. The input is typically connected to a 
motion detector or any other external security device, and images can be 
uploaded whenever the detector is activated. A maximum 40V DC is allowed on 
the inputs.
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Power connections
Power can be supplied to the camera by the following methods:

• Connect the supplied indoor power adapter to the power connector block and attach it to the camera 
casing. Note that this indoor power adapter provides power for the camera only.

• Connect an outdoor power supply to the power connector block and attach it to the camera casing.  
For information on available outdoor power supplies, please visit the Support pages at 
http://www.axis.com/techsup/

The power connector block supports both AC and DC input power. 

! IMPORTANT! - When using a DC power supply (included with this product), it is 
very important that it is connected correctly to the power block. Make sure the 
wire labeled with “+” is connected to pin 2 and the remaining wire GND to pin 3. 
With an AC power supply either wire can be connected to pin 1 or 2.
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I/O terminal connector blocks

Power/Audio
1 Power AC 18 - 30 VAC max 25VA power consumption.
2 Power  

AC/DC+
18 - 30 VAC max 25VA power consumption.
                              -or-
22 - 40 VDC max 20W power consumption.

3 GND Ground
4 Vout 12V/200mA

Vout can be used to power auxiliary equipment, 
max 200mA.

5 GND Ground
6 Line OUT Mono audio output (line level), which can be connected 

to an active speaker with built-in amplifier.
7 GND Ground
8 Mic/Line IN Input for a mono microphone or line level mono signal.
Output
1 Out1_1_relay On the external device output terminals (e.g. Out1_1 and 

Out1_2) there is no distinction between positive and neg-
ative. The terminals use a photocoupler and are electri-
cally isolated from the other internal circuitry.

The maximum load should not exceed 500mA and the 
maximum voltage should be not more than 50V DC. 
Note: Connecting AC to the Output will damage the unit.

2 Out1_2_relay
3 Out2_1_relay
4 Out2_2_relay
5 Out3_1_relay
6 Out3_2_relay
7 Out4_1_relay
8 Out4_2_relay
Input
1 In1_anode(+) Electrically isolated from the chassis and connectors, 

these inputs can be supplied from an external DC voltage 
or pin 4 (Vout) of the Power/Audio Connector and GND. 
(3.3 - 40VDC allowed on the inputs) 
The terminals use a photocoupler and are electrically iso-
lated from the other internal circuitry.
 
Note: There is a distinction between anode and cathode 
when making connections!

2 In1_cathode(-)
3 In2_anode(+)
4 In2_cathode(-)
5 In3_anode(+)
6 In3_cathode(-)
7 In4_anode(+)
8 In4_cathode(-)

Pin Function Description



 55 AXIS 233D - I/O terminal Connectors
Schematic Diagram - AXIS 233D I/O connectors and power
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Troubleshooting

Checking the Firmware

One of your first actions when troubleshooting a problem should be to check the currently 
installed firmware version. The latest version may contain a correction that fixes your 
particular problem. See the support section at http://www.axis.com/techsup for 
information on the latest available firmware version. The current software version in your 
AXIS 233D is available from the product Web pages under Setup > Basic Configuration.

Updating the Firmware

The firmware is software that determines the functionality of the AXIS 233D. When you 
upgrade to the latest available firmware from the Axis Web site, your Axis product will 
receive the latest available functionality. Always read the upgrade instructions and release 
notes available with each new release, before upgrading the firmware.

New firmware can be uploaded to the AXIS 233D over the network.

Note: Preconfigured and customized settings will be retained for use when the new firmware is running (provid-
ing that the features are available in the new firmware) although this is not guaranteed by Axis Communi-
cations.

1. Save the firmware file to your computer. The latest version of the AXIS 233D 
firmware is available free of charge from the Axis Web site at 
http://www.axis.com/techsup or from your local distributor.

2. Go to Setup > System Options > Maintenance in the AXIS 233D Web pages.

3. In the Upgrade Server section and browse to the desired firmware file on your 
computer. Click Upgrade.

Notes: After starting the process, you should always wait at least 20 minutes before restarting the AXIS 233D, 
even if you suspect the procedure has failed.



 57 AXIS 233D - Troubleshooting
Emergency Recovery Procedure
If power or the network connection to the AXIS 233D is lost during the upgrade, the 
process will fail and the unit will become unresponsive. When the status indicator flashes 
red it indicates a failed upgrade. To recover the unit, follow the steps below. The serial 
number is found on the label on the product casing and was included on an extra label 
included in the package.

1. Unix/Linux - From the command line, type the following: 
arp -s <IP address of AXIS 233D> <Serial number> temp 
ping -s 408 <IP address of AXIS 233D> 
 
Windows - From a command/DOS prompt, type the following: 
arp -s <IP address of AXIS 233D> <Serial number> 
ping -l 408 -t <IP address of AXIS 233D>

Note: the ping -l command is the lower-case letter (L) 

2. If the unit does not reply within a few seconds, restart it and wait for a reply. Press 
CTRL+C to stop Ping.

3. Open a browser and type in the AXIS 233D’s IP address. In the page that appears, use 
the Browse button to select the upgrade file to use, e.g. axis233d.bin. Then click the 
Load button to restart the upgrade process. 

4. After the upgrade has completed (1-10 minutes), the unit will automatically restart and 
show a steady green (for about 10 seconds) on the status indicator before returning to 
it’s normal unlit status. 

5. Reinstall the AXIS 233D. 

If the emergency recovery procedure does not get the AXIS 233D up and running again, 
please contact Axis support at www.axis.com/techsup/ 
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LED Indicator flash routine

Normal boot 
sequence

Unlit Power on 
RFL check

Amber Kernel booting 
System initiating

Green Shows steady green for 10 sec. for normal 
operation after restart.

Unlit Steady connection/normal operation
Hard Factory 
Default

Unlit Power on 
RFL check

Amber Steady - Kernel booting 
Flashes - Firmware restore 
Steady - System initiating

Green Shows steady green for 10 sec. for normal 
operation after restart.

Unlit Steady connection/normal operation
Flash Upgrade Unlit Steady connection/normal operation

Amber Flashes - Firmware upgrade
Unlit Reset 

RFL check
Amber Steady - Kernel booting 

Flashes - Firmware restore 
Steady - System initiating

Green Shows steady green for 10 sec. for normal 
operation after restart.

Unlit Steady connection/normal operation
No Network Unlit Power on 

RFL check
Amber Kernel booting 

System initiating
Amber/red Flashes - No network
Green Network connected/normal operation 

(10 sec.)
Unlit Steady connection/normal operation

AXIS DynDNS Unlit Steady connection/normal operation
Green Flashes- Dyn DNS connecting 

Steady - DynDNS successful (10 sec.)
Red Steady - DynDNS failed (10 sec)
Unlit Steady connection/normal operation

Bad Checksum Red Flashes - RFL check failed

Case Color Description
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Support

If you contact Axis Customer Services, please help us help you resolve your problems 
expediently by providing a server report, log file and a brief description of the problem.

Server Report - go to Setup > System Options > Support Overview. The server report 
contains important information about the server and its software, as well as a list of the 
current parameters.

Log file - go to Setup > System Options > Logs & Reports. The Log file records events 
within the unit since the last restart of the system and can prove a useful diagnostic tool 
for troubleshooting.
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Symptoms, Possible Causes and Remedial Actions  
Problems setting the IP address

Using ARP Ping The IP address must be set within two minutes after the power has been applied to the AXIS 
233D, restart the server and try again. Also, make sure the ping length is set to 408. See the 
ARP ping description in the installation section.

The AXIS 233D is located on a 
different subnet.

If the IP address intended for the AXIS 233D and the IP address of your computer are located 
on different subnets, you will not be able to set the IP address. Contact your network adminis-
trator for an IP address on the same subnet as the computer you are performing the installation 
from.

The IP address is being used by 
another device

Disconnect the power from the AXIS 233D.  
Run the Ping command (in a Command/DOS window, type ping and the IP address of the unit). 

If you receive: Reply from <IP address>: bytes = 32; time = 10 ms..... - this means that the IP 
address may already be in use by another device on your network. You must obtain a new IP 
address and reinstall the unit. 

If you receive: Request timed out - this means that the IP address is available for use with your 
AXIS 233D. In this case, check all cabling and reinstall the unit.

The AXIS 233D cannot be accessed from a Web browser
Cannot log in. If the AXIS 233D has been configured to use HTTPS, check that the protocol in the URL used to 

access the unit is correct. You may need to type this in manually (i.e. http or https) in the 
browser’s address field.

The IP address has been changed 
by DHCP

1) Move the AXIS 233D to an isolated network or to one with no DHCP or BOOTP server. Set the 
IP address again, using AXIS IP Utility or the ARP Ping command. 
2) Access the unit and disable BOOTP and DHCP in the TCP/IP settings. Return the unit to the 
main network. The unit now has a fixed IP address that will not change. 
3) As an alternative to 2), if dynamic IP address via DHCP or BOOTP is required, select the 
required service and then configure IP address change notification from the network settings. 
Return the unit to the main network. The unit will now have a dynamic IP address, but will 
notify you if the address changes.

Other networking problems Test the network cable by connecting it to another network device, then Ping that device from 
your workstation. See instructions above.

Cannot send notifications, uploads, alarms, etc, to a destination outside the local network
Firewall protection The AXIS 233D can be configured to use a SOCKS server to reach networks on the other side of 

a firewall/proxy server. See  SOCKS, on page 47 for more information.

Your AXIS 233D is accessible locally, but not externally
Firewall protection Check the Internet firewall with your system administrator.

Default routers required Check if you need to configure the default router settings.

The Internet site is too heavily 
loaded

Use a script running on your web server to relay images from the AXIS 233D to the Internet. 

The status indicator flashes red
A firmware upgrade has been 
interrupted or the firmware has 
in some other way been dam-
aged.

A rescue firmware is running in the product. First, set the IP address using AXIS IP utility or ARP 
and Ping,

Then, from a Web browser, access the unit and upgrade the latest firmware to the product, see 
Updating the Firmware, on page 56.

No images are displayed in the Web interface
Problem with AMC  
(Internet Explorer only)

To enable the updating of images in Microsoft Internet Explorer, set your Web browser to allow 
ActiveX controls. Also, make sure that AXIS Media Control (AMC) component is installed on 
your workstation. 

Installation of additional ActiveX 
component restricted or prohib-
ited

Configure yourAXIS 233D to use a Java applet for updating the images under 
Live View Config > Layout > Default Viewer for Internet Explorer. See help files for more infor-
mation.

Video Image Problems
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For additional assistance, please contact your reseller or check the product’s support pages 
on the Axis Website at http://www.axis.com/techsup

Image too dark or too light. See the help files on Video & Image Settings

Problems uploading own files There is only limited space available for the upload of your own files. Try deleting one or more 
existing files, to free up space.

Missing images in uploads This can occur when trying to use a larger image buffer than is actually available. Try lowering 
the frame rate or the upload period.

Slow image update Configuring, e.g. pre-buffers, hi-res images, high frame rate etc will reduce the performance of 
the AXIS 233D. 

Slow performance Slow performance may be caused by e.g. heavy network traffic, many users with access to unit, 
low performing client, use of features such as Event handling., Image rotation.

Bad snapshot images
Display incorrectly configured on 
your workstation

In Display Properties, configure your display to show at least 65000 colors, i.e. at least 16-bit.

Using only 16 or 256 colors on your display will produce dithering artifacts in the image. 

Problems with the MPEG-4 format
Lower frame rate than expected. Check with the administrator that there is enough bandwidth available. Check also the settings 

for bit rate control, in the Video & Image > Advanced > MPEG-4 settings. Using an inappro-
priate video object type can also affect the frame rate. See the online help for more informa-
tion.

Check in the AMC control panel applet (MPEG-4 tab) that video processing is not set to Decode 
only I frames.

Lower the image resolution.

Reduce the number of applications running on the client computer.

No MPEG-4 displayed in the  
client.

Check that the correct network interface is selected in the AMC control panel applet (network 
tab). 

Check that the relevant MPEG-4 connection methods are enabled in the AMC control panel 
applet (network tab). 

In the AMC control applet, select the MPEG-4 tab and click the button Set to default MPEG-4 
decoder. 

No multicast MPEG-4 displayed 
in the client.

Check with your network administrator that the multicast addresses used by the  
AXIS 233D are valid for your network.

Check with your network administrator to see if there is a firewall preventing viewing.

Multicast MPEG-4 only accessi-
ble by local clients. 

Check if your router supports multicasting, or if the router settings between the client and the 
server need to be configured. The TTL (Time To Live) value may need to be increased.

Poor rendering of MPEG-4 
images. 

Color depth set incorrectly on clients. Set to 16-bit or 32-bit color.

Unexpected PTZ behavior
Problem with hardware Go to System Options > Maintenance > Dome Status and click Test to test the camera and 

dome mechanics for errors. Contact Axis Customer Services if you receive an error message as 
the result of this test.
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Technical Specifications

Item Specification

Models • AXIS 233D Network Dome Camera 60 Hz
• AXIS 233D Network Dome Camera 50 Hz

Image sensor • 1/4” ExView HAD Progressive Scan CCD

Lens • F1.4 - 4.2
• F=3.4 - 119mm
• Automatic day/night IR filter
• Autofocus with 35x optical zoom
• Focus range: 100mm (wide) or 1000 mm (tele) to infinity

Angle of view • Horizontal: 1.73 - 55.8o 

Zoom • 35x optical and 12x digital, Total 420x

Minimum illumination • Color: 0.5 lux at 30 IRE
• Black/white: 0.008 at 30 IRE

Range • Pan: 360o continuous

• Tilt: 180o 

Speed Range • Pan: 0.05 - 450o/sec

• Tilt: 0.05 - 450o/sec

Video compression • Motion-JPEG 
• MPEG-4 Part2 (ISO/IEC 14496-2) with motion estimation
• Profiles: ASP level 0-5 and SP level 0-3

Resolutions • 4CIF, 2CIFExp, 2CIF, CIF, QCIF
• Maximum 768x575 (PAL) 704x480 (NTSC)
• Minimum 176x144 (PAL) 160x120 (NTSC)
• Horizontal resolution: 540 TVL

Frame rates (NTSC/PAL) • Up to 30/25 fps progressive scan video in all resolutions (Motion JPEG or MPEG-4)

Video streaming • Simultaneous Motion JPEG and MPEG-4
• Controllable frame rate and bandwidth
• Constant and variable bit rate (MPEG-4)

Image settings • Wide Dynamic Range (WDR)
• Electronic image stabilization
• Automatic IR filter removal
• Compression levels: 100
• Manual shutter time settings

• Rotation: 0o, 180o

• Aspect ratio correction
• Color and black/white
• Configurable Brightness and Sharpness
• Overlay capabilities: OSDI, preset ID, time, date, PTZ coordinates, text or image, 

Privacy mask in 8 zones

Pan/Tilt/Zoom • E-flip
• 100 preset positions
• Guard tour
• Control queue
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Shutter time • 1.5s PAL(1/2s NTSC) - 1/30000s

Audio • Two-way (full or half duplex) or one-way
• Audio compression: G.711 PCM 64kbit/s, G726 ADPCM 32 or 24 kbits
• Requires external microphone or line in.
• Mono audio output (line level) connects to PA system or active speaker with 

built-in amplifier.

Security • Multiple user access levels with password protection
• IP address filtering
• HTTPS encryption

Users • 20 simultaneous viewers
• Unlimited number of users using MPEG-4 multicast

Alarm and event 
management

• Events triggered by built-in motion detection, PTZ position, audio detection, 
external inputs, temperature levels or according to schedule

• Image upload via FTP, e-mail and HTTP
• Event notification via TCP, e-mail, HTTP and external outputs
• Pre- and post-alarm buffer of 36 MB 

Connectors • Ethernet 10BaseT/100BaseTX, RJ-45
• Three 8 pin connectors 

4 alarm inputs 3.3 - 40VDC 
4 relay outputs 50V 500 mA 
Power in 
Auxiliary power out 12VDC max 200mA 
Audio line/Mic in 
Audio line out

Casing • Metal/plastic casing
• Polycarbonate dome cover

Processors, memory and 
clock

• CPU: AXIS ETRAX FS 32-bit RISC CPU
• Compression: AXIS ARTPEC-2 video compression chip + 8MB RAM
• RAM: 64MB 
• Flash memory: 8 MB
• Battery backed up real-time clock

Power Power supply (indoor) included:
• 18-30 VAC, Max 25VA
• 22-40 VDC, Max 20W

Operating conditions • Temperature: -5 - 45o C (23 - 113o F)
• Humidity: 20 - 80% RH (non-condensing) 

Alarm when out of operating range.

Installation, management 
and maintenance

• Configuration backup and restore
• AXIS Camera Station One for recording
• AXIS Camera Management on CD and web-based configuration
• Firmware upgrades over HTTP or FTP. Firmware available at www.axis.com

Video access from Web 
browser

• Camera live view for up to 20 clients
• Video recording to file (ASF)
• Sequence tour for up to 20 Axis video sources
• Customizable HTML pages.

Item Specification
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Minimum web browsing 
requirements

• Pentium III CPU 500 MHz or higher or equivalent AMD
• 128 MB RAM
• AGP graphics card 32MB RAM, DirectDraw
• Windows: 2003 Server, XP, 2000 
• DirectX 9.0 or later
• Internet Explorer 6.x or later
• For other operating systems and browsers, see www.axis.com/techsup

System integration 
support

• Open API for application integration, including AXIS VAPIX API*, AXIS Media 
Control SDK*, event trigger data in video stream

• Quality of Service (QoS) Layer 3, DiffServ Model
• Watchdog ensures continuous operation, event notifications which can be 

monitored by other systems
• Embedded operating system: Linux 2.6

*Available at www.axis.com

Supported protocols IPv4/v6, HTTP, HTTPS, SSL/TLS*, TCP, QoS,SNMPv1/v2c/v3 (MIB-II),RTSP, RTP, UDP, 
IGMP, RTCP, UDP, SMTP, FTP, ICMP DHCP, UPnP, Bonjour, ARP, DNS, DynDNS, SOCKS, 
IEEE802.1X.  
More information on protocol usage available at www.axis.com 
*This product includes software developed by the Open SSL Project for use in the 
Open SSL Tool kit (www.openssl.org)

Accessories (included) • Indoor power supply AXIS PS-R 24VDC
• Drop ceiling and hard ceiling mount
• Clear and smoked dome covers
• Installation Guide
• CD with installation tool, software, User’s Manual and AXIS Camera Management

Video management 
software (not included)

• AXIS Camera Station - Surveillance application for viewing, recording and 
archiving up to 25 cameras

See www.axis.com/partner/adp_partners.htm for further software applications via 
partners

Accessories (not included) • Outdoor housing solutions
• Indoor ceiling drop pole mount
• Outdoor power supply
• IR illuminators
• AXIS 295 Video Surveillance Joystick
• MPEG-4 Decoder multi-user license pack

Approvals - EMC EMC
• EN55022:Class B
• EN55024:1998
• EN61000-3-2:2000 
• EN61000-3-3:2000
• EN61000-6-1
• EN61000-6-2

Safety
• EN60950-1 (IEC 60950-1) 
• PSE, TUV/GS, cUL, CE, CB, SAC (PS-R 

Power supply)

• VCCI Class B
• C-Tick AS/NZS 3548
• FCC Part 15 Subpart B, Class B
• ICES-003 Class B

Dimensions (HxWxD) and 
weight

• 209 x 170 x 170 mm (8.23” x 6.69” x 6.69”)
• Weight: 2.5 kg (5.5 lbs) including hard ceiling mount, excluding power supply

Item Specification
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General performance considerations

When setting up your system, it is important to consider how various settings and 
situations will affect performance. Some factors affect the amount of bandwidth (the bit 
rate) required, others can affect the frame rate, and some will affect both. If the load on the 
CPU reaches its maximum, this will also affect the frame rate.

The following factors are among the most important to consider:

• High image resolutions and/or lower compression levels result in larger images. 
Bandwidth affected. 

• Access by large numbers of Motion JPEG and/or unicast MPEG-4 clients. Band-
width affected.

• Simultaneous viewing of different streams (resolution, compression, etc.) by dif-
ferent clients. Frame rate and bandwidth affected.

• Accessing both Motion JPEG and MPEG-4 video streams simultaneously. Frame 
rate and bandwidth affected.

• Heavy usage of event settings affects the CPU load. Frame rate affected.
• Heavy network utilization due to poor infrastructure. Bandwidth affected.
• Viewing on poorly performing client PC’s lowers perceived performance. Frame 

rate affected.

Optimizing your system

To see the bandwidth and frame rate currently required by the video stream, the AXIS 
233D provides a tool that can be used to display these values directly in the video image.

To do this, special format strings are added as part 
of a text overlay. Simply add #r (average frame 
rate in fps) and/or #b (average bandwidth in Kbps) 
bandwidth in Kbps) to the overlay. 

For detailed instructions, please see the online help 
for Video & Image > Overlay Settings, and the 
help for File Naming & Date/Time Formats. 

Important!
• The figures displayed here are the values as delivered by the server. If other restrictions are  

currently in force, (e.g. bandwidth limitation) these values might not correspond to those  
actually received by the client.

• For Motion JPEG, these values will only be accurate as long as no frame rate limit has been specified.
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Frame rates 

Motion JPEG 
Test results show the frame rates in frames/second (fps) for Motion JPEG streams from the 
AXIS 233D, using a compression level of 50% is 25 fps for PAL and 30 fps for NTSC. Note 
that these values are guidelines only - actual values may vary.

MPEG-4
Test results show the frame rates in frames/second (fps) for MPEG-4 streams from the AXIS 
233D is 25 fps for PAL and 30 fps for NTSC. Note that these values are guidelines only - 
actual values may vary.

The MPEG-4 test conditions:

• Compression level = 50%
• Video Object Type = Advanced Simple
• GOV structure = IP

Bandwidth

As there are many factors affecting bandwidth, it is very difficult to predict the required 
amounts. The settings that affect bandwidth are:

• the image resolution
• the image compression
• the frame rate
• the MPEG-4 object type
• the MPEG-4 GOV structure

There are also factors in the monitored scene that will affect the bandwidth. These are: 

• the amount of motion
• the image’s complexity
• the lighting conditions.

For MPEG-4, if there is only limited bandwidth available, and if this is more important 
than the image quality, using a constant bit rate (CBR) is recommended. Use a variable bit 
rate (VBR) if the image quality needs to be maintained at a higher level. If supported on the 
network, consider also using MPEG-4 multicasting, as the bandwidth consumption will be 
much lower.
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F
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Live View 17
Logs & Reports 50
Low light behavior 21

M
Motion JPEG 13
Mozilla Firefox 12
MPEG-4 13
MPEG-4 clients 16
MPEG-4 Decoder 64
MPEG-4 protocols 14
Multicasting 14

N
NAT traversal 45
Network 43
New Server Time 41
Noise canceller attenuation 25
Notification of IP address change 43

O
Output 52, 54
Output Buttons 10, 28
Overlay Image 19
Overlay Settings 19
Own home page 27
Own web files 27

P
Pan/Tilt/Zoom Control Queue 11
Pan/Tilt/Zoom Controls 11
Pinout 48
Plain Config 50
Port Status 37, 38
Ports & Devices 48
Post-trigger Buffer 35
Power 54
Preset Positions 31
Pre-trigger Buffer 35
PTZ commands 27
Pulse 10, 28
Push to talk 23

Q
QoS 47
QuickTime 29

R
RADIUS 41
Recovery 57
Referrals 39
Relay outputs 52
Restart 48
Restore 48
RTP 14
RTSP 14, 46

S
Scheduled Event 33, 36
Security 39
Sequence Mode 10
Sequence mode 31
Services 43
Setup Tools 17
Sharpness 20
Simplex - Network Camera speaker only 23
SMTP 47
Snapshot 10
SNMP 48
Specifications 62
Streaming MPEG-4 15
Support 50
System Options 39
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Time Mode 42
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Video format 10
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